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Introduction 

 

The 2016.3 release delivers over twenty of the most requested enhancements 
registered and voted for on the Exo Business ideas portal, together with a refresh of 

-
modules and allows for main form panels to expand proportionally when you enlarge 
the form size. Also significant is a further enhancement of the New Zealand GST return 
web service to handle provisional tax payment or refund offset. 

2016.3.1 Service Pack 
This release includes the 2016.3.1 Service Pack, which includes improvements to the 
Export to Excel function for Clarity reports, as well as other usability improvements to 
the reporting interfaces. 

2016.3.2 Service Pack 
This release includes the 2016.3.2 Service Pack, which provides a compliance update to 
the Standard Business Reporting (SBR) features that allow the Taxable Payments 
Annual Report (TPAR) to be submitted to the ATO electronically. 

 

The purpose of this document is to provide essential information on the installation 
and use of this release: 

• The Installation section provides an overview of the installation process, 
including pre-installation requirements and post installation steps. 

• The New Features section describes all new features introduced in this release. 

• The Resolved Issues section describes all issues that have been addressed by 
this release. 

• The Known Issues section details any issues in this release that have been 
identified as requiring attention. 

• The New Profile Settings appendix at the end of this document summarises all 
changes to Exo Business profile settings included in this release. 
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Installation 

Pre-Install Requirements 

Minimum system requirements for PCs running MYOB Exo Business components are 
detailed below. Full details of requirements and supported operating systems for 
MYOB Exo Business are available on the Minimum System Requirements page on 
the MYOB website. 

The performance of the Exo Business system is not assured if these requirements are 
not met. Similarly, performance cannot be assured if the Exo Business system is 
installed on a server that is already under load from other processes, or a RDBMS that 

SQL Express  on page 3). 

Database Server 
MYOB Exo Business 2016.3 works best on Microsoft SQL Server 2014 (version 
12.0.2495.0) Standard or Enterprise editions. 

Any server where an MYOB Exo Business database is installed should meet the 
following minimum requirements: 

• Windows Server 2008, Windows Server 2012 

• The latest Service Pack for the Windows operating system 

• Intel Pentium® 4 2.4Ghz processor (or equivalent)  

• 2 GB RAM  

• 20 GB of hard disk space + 10 MB per user 

• Microsoft Data Access Components (MDAC) 2.8 or later 

• A supported version of Microsoft SQL Server: 

o Microsoft SQL Server 2008 R2/SQL 2008 R2 Express Edition 

o Microsoft SQL Server 2012/SQL 2012 Express Edition (however, see the 
Known Issue on page 45). 

o Microsoft SQL Server 2014/SQL 2014 Express Edition 

• The latest Service Pack for the version of SQL Server you are using 

Note:  Microsoft SQL Server 2016 is not currently supported. 

SQL Server 
Microsoft SQL Server must be present on the Exo Business Database Server. If you 
want to use a specific edition of SQL Server, make sure it is installed before running 
the Installation Wizard. If SQL Server is not installed, the Exo Business Installation 
Wizard can install SQL Server 2008 R2 SP1 Express Edition (SQL Express) as part of the 
installation process (see page 7). Whichever version of SQL Server you use, it must be 
set up to use Mixed Mode authentication. 

  

http://help.myob.com.au/exo/sysreqs.htm
http://help.myob.com.au/exo/sysreqs.htm
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The blank and demo databases supplied with Exo Business have their compatibility 
levels set to SQL Server 2008 (100) . When upgrading from a previous version of Exo 
Business, database compatibility levels are updated automatically as follows: 

• SQL Server 2008 and later databases are set to compatibility level 100. 
• Older versions of SQL Server are not updated. 

See the following web page for information on compatibility levels: 

http://msdn.microsoft.com/en-us/library/bb510680.aspx 

SQL Express 
SQL Express may not be suitable for businesses with many users. SQL Express has 
limits on the amount of RAM and number of processors it can use, which affects the 
number of concurrent users that the Exo Business database can support. See the 
following MSDN article for more information: 

http://msdn.microsoft.com/en-us/library/cc645993.aspx 

Client Workstation 
Any client workstation running the MYOB Exo Business application modules should 
meet the following minimum requirements: 

• Windows 7 Enterprise, Windows 7 Professional, Windows 7 Ultimate, 
Windows 8, Windows 10 

• The latest Service Pack for the Windows operating system 

• Intel Pentium® 4 1.3 GHz processor (or equivalent) 

• Hard disk space as required for the operating system 

• 16-bit colour, 1024×768 screen resolution 

Other Requirements 
Certain features of MYOB Exo Business require one or more of the following: 

• Internet access 

• Microsoft Internet Explorer 7.0 or later 

• Adobe® Acrobat Reader 7.0 or later 

Microsoft Office connection requires Microsoft Word/Excel 2010 to 2016. 

Contact synchronisation requires Microsoft Outlook 2010 to 2016. 

MYOB Exo Business 2016.3 requires ExonetLib.dll version 2016.3.0 or later. Version 
2016.3.0 is included with this release. 

When installing manually on 64-bit operating systems, the file RwEasyMAPI64.exe 
must be copied from the Supporting Files\RapWare folder of the Exo Business DVD to 
the install directory. Register this file by running RwEasyMAPI64.exe /regserver 
from a command prompt. 

http://msdn.microsoft.com/en-us/library/bb510680.aspx
http://msdn.microsoft.com/en-us/library/cc645993.aspx
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Installing MYOB Exo Business 

Note:  Before you install this release, we recommend you take the precaution of 
backing up your data. Ensure there are no Exo Business modules running, 
locally or on your network. 

To perform the installation: 
1. Insert the MYOB Exo Business CD and select Install MYOB Exo Business on the 

Install tab. If the install menu does not run automatically, run the 
ExoBusinessInstaller.exe program in the Supporting Files directory of the CD. 

2. Click Next on the Welcome screen. 

 
3. Read the licence agreement, then select I accept the agreement and click Next. 
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4. Select the country you are based in and click Next.  

 

Note:  Your selection here affects certain country-specific default settings that are 
set up during the install, e.g. tax rates and banks. 

5. Select the components to install. Choose from: 

• MYOB Exo Business Application Modules 

• Documentation files 

• Exo Business utilities 

• A blank live  MYOB Exo Business Database 

• A pre-configured demonstration database 

• Exo Business Common Files 

Click Next to continue. 
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6. If you chose to install the MYOB Exo Business Application Modules, click 
Browse to choose the directory where you want to install the program files, 
then click Next. 

 
7. If the MYOB Exo Business Common Files are not installed on this PC, click 

Browse to choose the directory where the Common Files are located, then click 
Next. 
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8. If you chose to install the MYOB Exo Business Database components, you must 
specify where to install the database: 

• To install on an existing SQL Server instance, select the instance and enter 
a user ID and password for that instance. 

• To create a new instance for the installation, select New SQL Server 
instance on this computer, then click Browse to choose the location of 
the new instance. This will install SQL Server 2008 Express Edition. 

Note:  See the Known Issues section on page 42 for information on the install pre-
requisites for SQL Server 2008 R2 SP1. 

Click Next. 

 

Note:  The installer may appear unresponsive while it tries to detect SQL Server 
instances on the PC (this process may take a minute or more). Do not cancel 
the installer; simply wait until the detection operation is complete. 

If you select to install a new instance of SQL Express, the logon details for the 
new instance will be: 

• Username: sa 

• Password: ģExoAdmin7000 

You will need to supply these details when migrating data, or if you want to 
connect to the SQL Express instance for any other reason. 
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9. Click Browse to choose where the MYOB Exo Business shortcuts should be 
located in the Windows Start menu, then click Next. 

 
10. If you want to create a desktop icon or Quick Launch icon for MYOB Exo 

Business, tick the relevant box(es), then click Next. 
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11. The installation is ready to begin. Review the details and click Install to proceed. 
If you need to change any details, click Back to return to the previous screen 
and change your selections. 

 
12. The installation progress is displayed. 

 

Note:  During installation, other windows may appear if SQL Express is being 
installed. 

 

  



Installation 

Exo Business 2016.3 Release Notes Page 10 of 46 
Copyright 2017 MYOB Technology Pty Ltd. 

13. If you chose to install the application modules but not the database 
components on this PC, you must enter the details of the database once the 
installation has completed. Click Test Connection to check that the details you 
have entered work. If the test passes, click Next. 

 

Note:  Once a computer successfully connects to the database, a Computer profile 
is created for it in Exo Business Config. 

14. The installation is now complete. Choose what to do next and click Finish: 

• Run MYOB Exo Business to explore the demonstration database. 

• Run the Configuration Assistant to set up your new MYOB Exo Business 
database. 

• Return to Windows. 
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Post-Installation 

Once MYOB Exo Business software is installed, it must be configured for use. 
Optionally, data can be migrated into the Exo Business system from another MYOB 
product. The configuration and migration processes are detailed in the MYOB Exo 
Business Implementation Guide. 

Logging in to Exo Business 
New MYOB Exo Business databases are installed with one or more default user 
accounts. When logging in to Exo Business for the first time, you must supply the 
following login details. 

For a new blank database (EXO_LIVE): 

• Default admin user = ExoAdmin 

• Default admin password = ExoAdmin 

For the demonstration database (EXO_DEMO): 

• Default admin user = ExoAdmin 

• Default admin password = ExoAdmin 

• Default demo user = demo 

• Default demo password = DEMO 

Note:  Passwords are case-sensitive. 
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Installing Exo Business Services 

Once the Exo Business system is set up, you can install supporting services for the Exo 
API and Exo Email Service using the Exo Business Service Setup Wizard, Exo Business 
Services Installer.msi. This installer is supplied with the main Exo Business installer. It 
must be run on a server that already has Exo Business installed on it, and must be run 
from an account with administrative permissions. 

To perform the installation: 
1. Double-click on the installer to run it. The welcome screen appears: 

 
2. Click Next. The MYOB Exo End User Licence Agreement is displayed: 
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3. Tick I accept the terms in the Licence Agreement and click Next to continue. 

 
4. Select which components to install. Choose from: 

• The Exo API Service 

• The Exo Messaging Service 

Note:  The API configuration utilities are always installed (see Setting up the 
Services  on page 15). 

5. The install location is displayed at the bottom of the window. Click Browse to 
choose a different location if necessary. 

6. Click Next. You are now ready to install the Exo Business services. 
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7. Click Install to being the installation. The progress of the installation is 
displayed: 

 
8. Once the installation is complete, click Finish to close the wizard. You can 

choose to open the Exo Business Service Configuration utility to set up details 
of the Exo API services. 

 

Note:  The Exo Business Service Configuration utility is installed in the same location 
as the Exo API services. You can run the utility 
(MYOB.ED.EXO.Cloud.ServiceConfig.exe) from this location at any time. 
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Setting up the Services 
The Exo Business services must be set up for each Exo Business database connection, 
using the MYOB Exo Business Service Configuration utility. This utility, 
MYOB.ED.EXO.Cloud.ServiceConfig.exe, can be run immediately after installation, or 
you can open it from the Exo services install directory at any time. 

Note:  All setup must be performed on the server that the Exo Business services are 
installed on, using an account with administrator privileges. 

 
The utility displays configuration settings for the following services: 

• Exo API Configuration 

o API Services  this is the main Exo API service. 

o API Provider Services  this service connects the Exo API to the online 
relay. This service is only needed this if you want to communicate with 
the Exo API remotely. 

• Exo Business Alerts Configuration 

o Message Services  this is the Exo Business messaging (email) service.  

To configure an API service, select an Exo Business database connection, then click the 
relevant Add Service button. For the API Service, you must also enter a Base URL, 
which is the location and port the API is accessible on (the default should be suitable in 
most cases, unless you want to use a different directory and/or port). 

Note:  For local API access, ensure that your firewall is configured to allow the 
relevant ports, services and/or applications. 

To validate that the Exo API has been successfully installed and set up, navigate to the 
Base URL in a web browser or REST client to see a list of available endpoints. 
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The configuration process for the messaging service is slightly different; where the API 
services create a separate instance for each Exo Business database connection, the 
messaging service has a single instance, which can have multiple connections to it. 

 
To install the messaging service instance, select a database connection and click Add 
Connection. This adds the service and sets up a connection to the selected database. 
To add new connections, select them from the EXO Connection dropdown and click 
Add Connection. 



 

Exo Business 2016.3 Release Notes Page 17 of 46 
Copyright 2017 MYOB Technology Pty Ltd. 

New Features 

Important Upgrade Notice 

The Exonetlib.dll DLL has been updated in this release. When upgrading manually, 
make sure to install and register the upgraded DLL its version number should be 
2016.3.0 or later. 

Improved Excel Export 

The feature was introduced in the 2016.3.1 Service Pack. 

This release introduces improvements when exporting reports to Microsoft Excel. 
These improvements relate to the XLSData output format, which produces an Excel file 
in columnar format with the emphasis on ensuring the data is formatted to allow 
further data manipulation. (The other Excel output format, XLSReport, places the 
emphasis on preserving the appearance and layout of the original report.) A new 
XLSXData output format is available, which functions the same as the XLSData format, 
but produces an .XLSX file, rather than an .XLS. 

On screens where reports can be exported to Excel, e.g. the Clarity Report Parameters 
window, the Export to XLS Report button on has been replaced with a new Export to 
Excel dropdown: 

 
The new dropdown contains three options: 

• Export to Excel 2007 and later (XLSX)  this uses the XLSXData output format 
to produce an Excel file in the .XLSX format. 

• Export to Excel 97  2003 (XLS)  this uses the XLSData output format to 
produce an Excel file in the older .XLS format. 

• Export to XLS Report  this uses the XLSReport output format to produce an 
Excel file in the .XLS format. 
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When selecting either of the first two options, the system now analyses the report and 
produces an automatically formatted Excel file that presents the data as clearly as 
possible. All report values and totals are presented with the columns, headings and 
formatting from the original report (including column widths, colours, text formatting 
and any data formatting like the number of decimal places or percentage signs). Any 
extraneous report elements, e.g. titles and other labels, appear to one side, where they 
can be easily deleted if necessary. 

Setting up Reports for Excel Export 
The default behaviour for the Excel export function is to analyse reports and auto-
format them as described above; however, if the Clarity report has been set up for 
Excel export, using the Print to File Setup window in the Exo Business Report Designer, 
the system will use this setup to produce the Excel report. 

The Print to File Setup window includes a new option to make it easier to set reports 
up for exporting to Excel. (Open the Print to File Setup window by selecting Print to 
File Setup from the File menu while on the Design tab.) 

 
Clicking the new Auto button automatically populates the Selected Controls pane, 
using the same analysis as the default Excel export function. The report data columns 
are sorted to the top of the pane (meaning they will appear on the left of the Excel file) 
and the titles, labels, etc. are sorted to the end. You can then delete any unnecessary 
columns or re-order them as necessary. Once the report is saved with the new Print to 
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File Setup configuration, this configuration will be used whenever the report is 
exported to Excel. 

To determine whether or not the Print to File Setup has been configured, the system 
looks at the Save property under Output - File for the Details section of the report. If 
this property is ticked, it knows the Print to File Setup has been configured, so it will 
use the saved configuration instead of trying to auto-format the report. 

 

Note:  All default reports that are installed with Exo Business have been configured 
for XLSData export. It may be useful to look at some of these reports to see 
how they have been configured, and use this as a guide when configuring 
your own custom reports. 
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Updates to Business Alerts 

This release adds the ability to set up new Business Alerts for a wide range of events. 
New event categories are available in the Rules for Event dropdown on the Business 
Alerts screen in Exo Business Config: 

• Save Debtor 
• Save Creditor 
• Save Non-Account 
• Save Contact 
• Save Stock Item 
• Save GL Account 
• Save Serviceable Unit 

The Business Alerts screen has been redesigned to group events into sections: 
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New Parameters 
The following new parameters are available for Business Alerts: 

Parameter Meaning 

General (available for all types)  

@NOW_STR The current date and time as a string in the format 'yyyy-mm-dd 
hh:MM:ss' (including quote marks). 

@TODAY_STR The current date as a string in the format 'yyyy-mm-dd' (including quote 
marks). 

Company accounts  

@ACCNO The Debtor, Creditor or Non Account's ID number. 

@ALHPACODE The Debtor or Creditor account's name. (Not available for Non 
Accounts.) 

@H A specified field from the DR_ACCS, CR_ACCS or PROSPECTS table. 

Contacts  

@CONTACTID The contact record's ID number. 

@ACCOUNTNAME The name of the company account that the contact is associated with. 

@H A specified field from the CONTACTS table, e.g. @H.FIRSTNAME. 

General Ledger accounts  

@ACCNO The GL account's ID number. 

@H A specified field from the GLACCS table, e.g. @H.BALANCE. 

Stock items  

@STOCKCODE The Stock item's ID code. 

@ACCNO The ID number of the stock item's supplier. 

@H A specified field from the STOCK_ITEMS table, e.g. @H.SELLPRICE1. 

Serviceable Units  

@UNITNAME The Serviceable Unit's name. 

@STOCKCODE The ID code of the stock item on the unit (this may be null). 

@H A specified field from the SU_MAIN  table, e.g. @H.UNITDESC. 

@W A specified field from the SU_WARRANTY  table, e.g. @W.EXPDATE. 



New Features 

Exo Business 2016.3 Release Notes Page 22 of 46 
Copyright 2017 MYOB Technology Pty Ltd. 

Maximum Number of Extra Fields 

In previous versions, the maximum number of Extra Fields that could be added to a 
table was 24. This version increases the limit to 38 for most tables; for tables that are 
accessible via the Exo API only, the limit has been increased to 100. 

Provisional Tax 

The NZ GST Return function can now include provisional tax information when 
submitting the GST Return to the IRD. You can pay provisional tax along with your 
GST, or, if your GST return shows a refund, you can apply some or all of this refund 
against the provisional tax amount. 

Note:  Exo Business does not support the Ratio method for calculating provisional 
tax. You will need to manually calculate and file your GST return if you are 
on the Ratio method. 

A new GST Return Type dropdown on the Header tab of the NZ GST Return window 
lets you specify whether or not the GST return should include provisional tax: 

 

Note:  If you pay provisional tax, you will need to select the : 
GST 103B option every period, even for periods where you are not paying 
provisional tax. 
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When the : GST 103B option is selected, an extra Provisional 
Tax tab becomes available. Once the GST return is calculated, you can enter 
provisional tax details into this tab. The available fields differ depending on whether or 
not the GST return indicates a payment (to which the provisional tax payment will be 
added) or a refund (which can be used to offset the provisional tax amount): 

 
The amounts on this tab are displayed on the printed GST Return report, and included 
in the return when s submitted to the IRD using the IRD button. (This was formerly 
the SBR button as Standard Business Reporting is specific to Australia, this 
terminology has been changed in the New Zealand interface). 
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When submitting a return that includes provisional tax, the provisional tax fields are 
added to the Submit GST Return Confirmation window: 

 
In New Zealand, the SBR Manager window has been renamed to Inland Revenue 
Lodgements. This window now includes extra columns related to GST returns. 

Update to Stock Search 

In previous releases, when entering a stock code and using the ? wildcard, if there was 
a record that matched the code exactly, it would be selected automatically and the 
Stock Search window would not appear. As of this release, when the ? wildcard is 
included in a stock code search, the Stock Search window always appears, showing 
any entries that match code. 

This can be useful when entering stock codes, as it shows the user any records that 
may be related to the entered code, which would not have been visible otherwise, e.g. 
related barcodes or stock items that have superseded the entered item. 
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Update to the Integrated Cashbook 

The Integrated Cashbook now supports more than 200 rows. By default, it pre-
allocates 200 rows (the maximum in previous versions), but it is now possible to add 
more rows by pressing the down arrow key while on the last row. 

Updates to the GL Report Writer 

This release adds setup options to the GL Report Writer, which provide more flexibility 
when setting up percentage-based columns, and allow report columns to be 
organised more neatly. Two new properties are available on the Report Column Setup 
window: 

 
all values 

in the column as percentages of a nominated total (the total is taken from the row 
specified by the % Row sequence setting). The new %Range Row Seq setting lets you 
specify a range for the percentage calculations the report will calculate percentage 
values for all rows between the %Range Row Seq row and the % Row sequence row, 
and leave all other rows blank. 

The new %Column Destination value lets you insert a range of percentage values into 
a different column. This allows you to set up multiple columns to calculate multiple 
ranges as percentages, then display all ranges in a single column on the printed report. 

The new options are supported when printing GL Reports, when printing them with a 
Clarity template, and when exporting them to Excel. 

Note:  If %Range Row Seq is set to -1, the system will behave as it did in previous 
versions and the %Column Destination setting will be ignored. 
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Example 

column 30 (<PERIOD>) as percentages of row 35 (Total Sales). The %Range Row Seq 
property is set to 25, which means that percentages will only be calculated from row 
25 (<Range of GL Account Groups>) to the Total Sales row. 

 

(<PERIOD>) as percentages of row 65 (Cost of Goods sold). The %Range Row Seq 
property is set to 55, which means that percentages will only be calculated from the 
second <Range of GL Account Groups> section to the Cost of Goods Sold row. 
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The effects of these settings can be seen when the report is previewed: 

 
The % of Sales  column contains percentage values for the Sales section only and the 

ains percentage values for the Less Cost of Sales section only. 

This report contains a lot of blank space in the columns
 

% Column Destination  
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When previewed, the report now shows both sets of percentage values in the same 
column (which has been rena ). 

 

ABN Verification 

For Australian companies, Exo Business can now verify the Australian Business 
Numbers (ABNs) entered for Debtors and Creditor accounts using an online service 
provided by MYOB. A new profile setting, Verification of the ABN against online 
resources, is available to control what sorts of account the system should use the 
verification service for. This setting has the following options: 

• None 
• Debtors 
• Creditors 
• Debtors and Creditors (this is the default) 

Online Connectivity Check 

A new Check Online Connectivity button is available on the About Exo Business 
window (Help > About). Clicking this button checks the status of the Exo Cloud 
Services, which provide functions such as geolocation services, Bank Feeds and ABN 
verification (see above). If there are any problems with connectivity, an error message 
containing details of the problems will be displayed. 
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New Clarity Methods 

This release adds new methods that can be used in Clarity reports. 

ShowGLCode 
procedure ShowGLCode(GLCode: string; HasBranch: Boolean); 

This opens the specified GL account from a Clarity report. The GLCode can be either a 
single number, e.g. 1000, or a formatted string, e.g. 1000-10 or 2-1000-10. 

For example, assuming a DBText field called GLAccNo, you can add an 
OnDrawCommandClick handler as follows: 

procedure GLAccNoOnDrawCommandClick(aDrawCommand: TObject); 

var 

  lDrawText: TppDrawText; 

begin 

  lDrawText := TppDrawText(aDrawCommand); 

  if lDrawText.Text <> '' then 

    ShowGLCode(lDrawText.Text, False); 

end; 

FormatExoProtocolLink 
function FormatExoProtocolLink(Command, Value: string): string; 

This will return an Exo protocol link for a specified Command and Value, e.g. 

Link := FormatExoProtocolLink('draccount', 10); 

This w exo://<current alias>/draccount(10)  into the link. 

This function can be used with the DBText.Hyperlink property in Clarity. Add a 
BeforePrint handler to the detail band, e.g. 

procedure DetailBeforePrint; 

begin 

  DBText1.HyperLink := FormatExoProtocolLink('draccount', 

MASTER['ACCNO']); 

end; 

Clicking on this link will then launch/open Exo Business, then open the relevant Debtor 
account. 

Note:  ShowGLCode uses the Exo protocol handler to enforce security constraints, 
i.e. as with all Exo protocol links, users cannot use them to access part of the 
Exo Business system that they do not have access rights for. 
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Geolocation Updates 

This release includes updates to the window that opens when Exo Business attempts 
to retrieve geolocation information for an address. The window has been reorganised 
to make it more compact, and features new controls that let you fine tune the way that 

 

 
The tick boxes next to each line in the Search Address panel can be used to exclude 
certain address lines from being matched; for example, if addresses have a building or 
unit number as the first line, this could be excluded from searches. 

Note:  You can also use the existing Geo coding address format for Australia and 
Geo coding address format for New Zealand profile settings to control how 
geolocation data is mapped to account addresses. 

Ticking the new Add Country button automatically appends the country to the end of 
addresses if it is not already there, which can be u

 

You can save these settings for all future searches by clicking the new Save Settings 
toolbar button. 
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Interface Updates 

Windows Aero Theme 
The Windows Aero theme is now enabled by default, providing a more modern 
interface that supports the Aero Flip and Peek features. These include enhanced 
ALT+TAB, CTRL+TAB and WINDOWS+TAB functionality which improve multitasking 
when working across several modules at once. 

In previous versions, this theme had to be enabled by running Exo Business 
executables with the /AERO flag. This flag is no longer supported; instead a /NOAERO 
flag is now available to disable the default Aero theme. 

Window Resizing 
The Exo Business interface now resizes proportionally to match the dimensions of the 
window. This affects the panes that make up each screen and various text entry fields, 
e.g. address fields. 

Note:  -
and select Form Position > Save. 

Rebranding 
The MYOB Exo Employer Services suite of products has been rebranded with an all 
new look and feel: 

 
When the DBUpdate process is run to upgrade to this version, the system attempts to 
install the new default Business Flow Menus. If no Business Flow Menus are in use, the 
default ones will be installed; if an older default menu is in use, the system will attempt 
to upgrade it to the new look. 
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For systems that use customised Business Flow Menus, new template menus are 
available in MYOB Exo Configurator at Staff > Menus > Business Flow Menu these 
templates can be used as the basis for new customised menus. 

Bank Feed Setup Columns 
The columns on the Setup Bank Feed Rules window have been rearranged to make 
the setup process more intuitive. The Link Operator and Invert columns are now on 
the left side of the Rule Conditions and Action Conditions sections, making it clearer 
that these operators apply to the current row, not the rows that follow it. 
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Cashbook Periscope 

The Options column on the Integrated Cashbook window contains an edit button for 
Expense and Income transactions; this button opens the Cashbook Periscope window, 
where GST details for the line can be edited: 

 

Session Idle Timeout 

This release adds the ability to configure an idle timeout for users, by configuring the 
new Idle session timeout period in minutes User-level profile setting. If this setting has 
a value greater than zero, then users will be logged out after a period of inactivity that 
exceeds the entered value (in minutes). 

Note:  Because this is a User-level profile setting, you can set different timeouts for 
different users, or have no timeout for some users. 

A warning message appears when the idle timeout has been exceeded: 

 
The user has 60 seconds to cancel, after which their session is ended and they are 
logged out of Exo Business. Their database connection is closed, any locks they had on 
records will be removed, and their licence will be freed up. If they had left any changes 
unsaved, these changed will be lost. 

Note:  Some key business processes are exempt from the timeout, including the 
MYOB Exo Configurator application. 
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2016.3.1 Service Pack 

The following new features were introduced in the 2016.3.1 Service Pack release. 

Improved Excel Export 
This release introduces improvements when exporting reports to Microsoft Excel. 
These improvements relate to the XLSData output format, which produces an Excel file 
in columnar format with the emphasis on ensuring the data is formatted to allow 
further data manipulation. (The other Excel output format, XLSReport, places the 
emphasis on preserving the appearance and layout of the original report.) A new 
XLSXData output format is available, which functions the same as the XLSData format, 
but produces an .XLSX file, rather than an .XLS. 

On screens where reports can be exported to Excel, e.g. the Clarity Report Parameters 
window or the Sales Analysis Designer, the Export to XLS Report button on has been 
replaced with a new Export to Excel dropdown: 

 
The new dropdown contains three options: 

• Export to Excel 2007 and later (XLSX)  this uses the XLSXData output format 
to produce an Excel file in the .XLSX format. 

• Export to Excel 97  2003 (XLS)  this uses the XLSData output format to 
produce an Excel file in the older .XLS format. 

• Export to XLS Report  this uses the XLSReport output format to produce an 
Excel file in the .XLS format. 

When selecting either of the first two options, the system now analyses the report and 
produces an automatically formatted Excel file that presents the data as clearly as 
possible. All report values and totals are presented with the columns, headings and 
formatting from the original report (including column widths, colours, text formatting 
and any data formatting like the number of decimal places or percentage signs). Any 
extraneous report elements, e.g. titles and other labels, appear to one side, where they 
can be easily deleted if necessary. 
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Setting up Reports for Excel Export 
The default behaviour for the Excel export function is to analyse reports and auto-
format them as described above; however, if the Clarity report has been set up for 
Excel export, using the Print to File Setup window in the Exo Business Report Designer, 
the system will use this setup to produce the Excel report. 

The Print to File Setup window includes a new option to make it easier to set up 
reports for exporting to Excel. (Open the Print to File Setup window by selecting Print 
to File Setup from the File menu while on the Design tab.) 

 
Clicking the new Auto Layout button automatically populates the Selected Controls 
pane, using the same analysis as the default Excel export function. The report data 
columns are sorted to the top of the pane (meaning they will appear on the left of the 
Excel file) and the titles, labels, etc. are sorted to the end. You can then delete any 
unnecessary columns or re-order them as necessary. Once the report is saved with the 
new Print to File Setup configuration, this configuration will be used whenever the 
report is exported to Excel. 

The new  and  buttons let you add and remove blank columns in the Excel 
output. This can be useful for rows that contain section totals you can include only 
those columns that you want to be totalled, and tell the output to skip the other 
columns by adding blank columns in their place. These blank columns have the prefix 
<SKIP> on the Print to File Setup window they do not appear in the printed output; 
only in Excel.  
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To determine whether or not the Print to File Setup has been configured, the system 
looks at the Save property under Output - File for the Details section of the report. If 
this property is ticked, it knows the Print to File Setup has been configured, so it will 
use the saved configuration instead of trying to auto-format the report. 

 

Note:  All default reports that are installed with Exo Business have been configured 
for XLSData export. It may be useful to look at some of these reports to see 
how they have been configured, and use this as a guide when configuring 
your own custom reports. 

Parameters on Report Previews 
When previewing a Clarity report, the report parameters now appear in a resizable 
pane on the left, so that you can change the preview without having to exit back to 
the Clarity Report Parameters window. This means that you can print out several 
versions of the report, or search for exceptions within a report quickly and easily. 
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Enhancements to Parameter Labels 
bels were always hard-coded; the release 

adds the ability to use the Display Names set up in EXO Business Config in parameter 

Caption field of the Parameters Editor window, wh
on the Display Names screen in EXO Business Config: 

 
For example, on the Stock Transaction Listing report (STTTransList.clr), the captions for 
the Stock Group parameters are hard-coded on the Parameters Editor window to 

 

 
  



New Features 

Exo Business 2016.3 Release Notes Page 38 of 46 
Copyright 2017 MYOB Technology Pty Ltd. 

If you have set up a different Display Name for the STOCKGROUP_SECONDARY field, 
you can enter @STOCKGROUP_SECONDARY into the caption at runtime, this will be 
replaced with the relevant Display Name. You can choose from a list of available 
Display Names by clicking on the new dropdown control on this field: 
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Changing the hard-coded caption names to use @STOCKGROUP_PRIMARY and 
@STOCKGROUP_SECONDARY results in the following captions when the report is 
run:  

 
In the screenshot above, the captions for the Primary Stock Group have been changed 

 

Update to the ABN Verification Service 
This release updates the ABN verification feature for company records; the system will 
now display a warning message if the verification fails, but will still allow the record to 
be saved. This gives administrators more flexibility to record company names as they 
see fit, which may be in a way that does not exactly match the name associated with 
the ABN. 

2016.3.2 Service Pack 

The following new feature was introduced in the 2016.3.2 Service Pack release. 

Updates to TPAR Submission 
The 2016.2 release of Exo Business added the ability to submit the Taxable Payments 
Annual Report (TPAR) to the ATO electronically using Standard Business Reporting 
(SBR).  

The ATO  SBR service has new authentication requirements; this release updates Exo 
Business so that it can continue to use this service.  
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Resolved Issues 

Exo Business Core 

Service Request ID  Description 

138636758892 138627316501 This issue was resolved in the Exo Business 2016.3.1 Service Pack. 

The History tab on the Sales Orders search window was not displaying 
data from the selected Sales Order. This has been resolved. 

12352902445 11302389807 
11515306213 11515956252 
11515956440 11379930268 
11379930498 11063280732 
11379930611 12233122561 
12596471411 12596471416 
19684004841 122129855511 
133831029671 

When a GL Report was set up with one or more columns of the 

report would calculate all values in the column as a percentage of the 
nominated total row, even if those values were not related to the total 
row. This has been resolved; new properties on the Setup GL Reports 
window let you specify the range of values that should be calculated as 
percentages see page 17. 

12352902445 11302389807 
11515306213 11515956252 
11515956440 11379930268 
11379930498 11063280732 
11379930611 12233122561 
12596471411 12596471416 
19684004841 122129855511 

This release adds features to the GL Report Writer that improve the 
behaviour of percentage columns and allow multiple percentage ranges 
to be included in one report see page 25. 

13235219285 17216787952 
18018803531 15903398501 
13260369741 13156398801 
13034026311 132278101371 
128120253431 124824014861 
113992313731 113292901361 
111377650945  

This release adds the profile setting Suppress contact history notes, 
which allows you to prevent history notes being created when adding or 
removing contacts from CRM contact lists and/or when emailing invoices 
to customers Appendix 1: Profile Settings 46 for details. 

12597484594 12580392125 
13307252531 

The Integrated Cashbook now supports more than 200 rows see page 
25 for details. 

11141712784 127355264001 
12082928065 11140342613 
12082928017 12293056199 
18113206171 18113206176 
18113206180 18113206184 
18113206196 18113206200 
12082928071 12082928053 
12082928059 

 

This release resolves the following issues involving the End of Period/End 
of Year process: 

• After running the End of Year process, the first period in the new 
year would have start and end dates from the previous year. 

• If the End of Year process was run for one ledger, then run again 
for the remaining ledgers, the year would become incorrect. 

• To prevent a user accidentally rolling the same period twice, the 
system now checks if any ledgers are being posted before their 
period end date, and warns the user if they are. 

12295703977 12288245295 
116334346101 116468533364 
116468533341 119273598511 
121041451435 120671201461 
136190626941 

GL Reports would not display any data if the Period Year in Header 
option was ticked on the Setup GL Reports window. This has been 
resolved. 
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11075722975 11018048658 
11990950021 13030789391 
18771499761 

This release makes it easier to copy Business Flow Menus for Exo Job 
Costing and Exo CRM from one menu to another. 

16972344449 15953474361 
16933645641 135029221071 

In previous versions, stock item images (specified on the Web tab of the 
Stock Item Details window) supported the GIF, JPG and BMP formats 
only. This release adds support for PNG, ICO, EMF and WMF image files. 

134304289620 134402430491 
113992313941 

When documents were imported to the Documents tab of an account, 
the document date would NULL if the file was open in another 
application. This has been resolved. 

12330152604 136188115531 
12320409901 

The Validate debtor order numbers profile setting saved the wrong 
default value, which meant that orders could be saved without an order 

Need Ord No option was ticked. This has 
been resolved. 

121041451435 120671201461 
136190626941 

GL Reports showed no data if the Period Year in Header option was 
ticked. This has been resolved. 

12016709708 12837745666 On the Rows and Columns tab of the Setup GL Reports window, after 
adding, editing, or deleting a row, focus always jumped to the top row of 
the grid. This has been resolved. 

125444195225 125126178911 Processing an Inwards Goods Receipts with a manual on-cost wrote an 
incorrect GL batch number to the STOCK_TRANS table, which meant that 
when transactions were posted to the General Ledger, the system would 
update the GL batch number of unrelated transactions. This has been 
resolved. 

136306006888 136279426721 When using fully-tracked serial numbers, old serial numbers (more than 

stock adjustments. This has been resolved. 

11698333175 11693304101 
138461512757 138457032352 

This release includes enhancements to the Stock Search functionality 
when using the ? wildcard see page 24. 

11609682359 11596213551  
134251696601 

11696803008 11613582591 
11050594878 

This release addresses the following issues relating to the Manual Cheque 
screen of the Creditors Payment Processor: 

• The error message Grid out of range.  appeared when tabbing to a 
new line. This has been resolved. 

• The error message List index out of bounds (-1).  appeared when 
entering a negative Expense. This has been resolved. 

• This release adds support for Analysis Codes to the Manual Cheque 
screen. 

12312747338 12302338353 If the Analysis Codes column on the Integrated Cashbook windows was 
hidden (by enabling the Hide Analysis Codes Column profile setting), 
some of the other columns, such as GST, could not be seen without 
scrolling. This has been resolved. 

116259668941  This release adds support for NVARCHAR Extra Fields. While it was always 
possible to manually insert Extra Fields as NVARCHAR, changes in recent 
releases meant that such Extra Fields could not be edited in Exo Business 
Config; this has been resolved. 
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131782658581  
tab, they were always stored in the Exo Business database, which could 
cause the database to become overly large over time. Drag and drop 
operations onto the Documents tab now use the Documents stored in 
database profile setting to determine whether documents should be 
stored or linked to. 

- If a widget that expected a contextual link to a record was added to a 
general dashboard, an exception would occur. This has been resolved; in 
such cases the system now handles the exception and the widget simply 
displays no data. 

138636758892 138627316501 This issue was resolved in the Exo Business 2016.3.1 Service Pack. 

The History tab on the Sales Orders search window was not displaying 
data from the selected Sales Order. This has been resolved. 

- This issue was resolved in the Exo Business 2016.3.1 Service Pack. 

Save & Exit on the 
Creditor Account Details windows. This has been resolved. 

- This issue was resolved in the Exo Business 2016.3.1 Service Pack. 

A confirmation message is now displayed before a user runs the System > 
Purge Records utility in Exo Business Config. 

- This issue was resolved in the Exo Business 2016.3.1 Service Pack. 

Access violation errors could occur in GL Reports when using the 2016.3 
version of Exonetlib.dll with versions prior to 2016.3. This has been 
resolved. 

141847980251 141596410541 
142262875741 

This issue was resolved in the Exo Business 2016.3.2 Service Pack. 

When a GL Report was exported to Excel 2007 or later (XSLX Data), 
negative values in the report would not appear as negative. This has 
been resolved. 

- This issue was resolved in the Exo Business 2016.3.2 Service Pack. 

In some cases, the Recent Items widget could steal focus from the 
window in front of it. This has been resolved. 

Exo Job Costing 

Service Request ID  Description 

11094254364 136050627971 
14635646251 11035344731 

When using the Create Asset function to create a batch-tracked item 
from batch-tracked component items, the system did not prompt for a 
batch number for the output item. This has been resolved. 

114517968580 114507491481 
114639197721 124346611281 
127057463881 137619963741 

This issue was resolved in the Exo Business 2016.3.1 Service Pack. 

An Access Violation error occurred after creating a Purchase Order for a 
Job, if the Debtor associated with the job had a pop-up alert defined. This 
has been resolved. 
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Exo Clarity 

Service Request ID  Description 

138636758892 138627316501 This issue was resolved in the Exo Business 2016.3.1 Service Pack. 

After closing Clarity, it still showed on the Windows task bar. This has 
been resolved. 

Exo Fixed Assets 

Service Request ID  Description 

11856719335 130650687134 
11848056300 11848056308 
11848056316 11848056324 
12180703628 

Disposing of an Asset after the End of Year process had run did not adjust 
Retained Earnings, which resulted in a GL imbalance. This has been 
resolved; when revaluing, selling or disposing of an Asset in the previous 
financial year, a GL transaction is now created for the Retained Earnings 
account which is the sum of the amount for transactions that affect profit 
and loss. 

Exo POS 

Service Request ID  Description 

- This issue was resolved in the Exo Business 2016.3.1 Service Pack. 

Due to the rebranding changes introduced in Exo Business 2016.3, 
running exonet.exe in POS mode was not supported. This has been 
resolved; the core Exo Business module now supports running in POS 
mode. 

Exo Distribution Advantage 

Service Request ID  Description 

140299717759 139121298301 This issue was resolved in the Exo Business 2016.3.1 Service Pack. 

Custom buttons that were set up to open the Batch Sales Order Line 
Processing (BSOLP) function from the Sales Order window did not pass in 
the current Sales Order; the BSOLP window opened at a blank Sales 
Order search screen. This has been resolved. 
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Known Issues 
The following issues have been identified as requiring end-user attention in this 
release. 

Installation/Upgrade Issues 

• If you are using the MYOB Exo Business Installation Wizard to install an 
instance of SQL Express, the following must be must be present on the PC: 

o .NET Framework 3.5 SP1  you can download this from: 
http://go.microsoft.com/fwlink/?LinkId=120550  

o Windows Installer 4.5  you can download this from: 
http://go.microsoft.com/fwlink/?LinkId=123422  

o Windows PowerShell 1.0  you can download this from: 
http://go.microsoft.com/fwlink/?LinkId=120552  

• Due to security settings imposed by Windows, CHM Help files cannot be 
viewed from a remote location this means that you can only view the Exo 
Business CHM Help files if they have been installed on the local PC. See 
Microsoft Knowledge Base article 892675 for more information on this issue 
and suggested workarounds. (This issue does not apply if you are viewing 
online Help files on the Exo Business Education Centre.) 

Demo Data Issues 
The stored procedure SP_DEMO_DATA_DATE_UPDATER, which updates the data in 
demo databases to the current date, was updated in Exo Business 8.4. This stored 
procedure is only available in the EXO_DEMO database, which means that any 
existing demonstration databases used by partners will not be able roll their demo 
data forward; these databases will need to be re-created based on the updated 
EXO_DEMO database in order to use the updated 
SP_DEMO_DATA_DATE_UPDATER procedure. 

Job Costing Resource Issues 
When a resource allocation is created, an Activity for the relevant staff member is 
automatically created in the Exo Business system; however, if the resource is not 
associated with a staff member, the Activity will not appear on the Activity Search 
widget on the Task Scheduler tab. 

As a workaround, a dummy staff account can be created to associate non-staff 
Resources with. 

  

http://go.microsoft.com/fwlink/?LinkId=120550
http://go.microsoft.com/fwlink/?LinkId=123422
http://go.microsoft.com/fwlink/?LinkId=120552
http://support.microsoft.com/kb/892675/


Known Issues 

Exo Business 2016.3 Release Notes  Page 45 of 46 
Copyright 2017 MYOB Technology Pty Ltd. 

SQL Server 2012 Issues 
All versions of SQL server 2012 exhibited a subtle, but now well-known change in 
default behaviour with regard to identity or auto number sequences. In MYOB Exo 
Business, this would be experienced as an unexpected anomaly where number 
sequences could apparently spontaneously jump by increments of 1000 if the SQL 
server was restarted. 

This behaviour was reversed in SQL server 2014, but no known solution exists for 
completely preventing this behaviour in any versions of SQL server 2012, other than to 
upgrade to SQL server 2014 to completely eliminate the potential for this issue to 
occur. 

SQL Server 2008 R2 prior to SP3 
MYOB Exo Business uses a SQL Server feature called Common Language Runtime 
Integration. This feature was disabled by default in versions of SQL Server 2008 R2 
prior to Service Pack 3. If this feature is not enabled, users may encounter the following 
error during the upgrade process: 

Updating server configuration: 'clr enabled' 
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Appendix 1: Profile Settings 
The following profile settings have been added or modified in this release. 

Name  Profile Name Level  Description Default Refer  

Idle session timeout period in 
minutes 

IDLETIMEOUT User Users are logged out if they remain active for the entered amount of 
time entered here (in minutes). If a value of zero is entered, no idle 
timeout will be applied. 

0 page 33 

Suppress contact history notes CONTACT_HIST_SUPPRESS_ 
ACTIONS 

Company Specify the actions for which history notes should not be created. Enter 
one or more of the following options: 

• L  Suppress history notes when adding or removing contacts 
from CRM contact lists. 

• I  Suppress history notes when emailing invoices to customers. 

blank page 40 

Verification of the ABN against 
online resources 

ABNCLOUDVALIDATION User Choose whether or not to verify ABNs entered for Debtors and/or 
Creditors using the MYOB  

Debtors and 
Creditors 

page 28 
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